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This manual is part of a set of the supplier E-750 documentation that includes the 
following manuals for users and system administrators:

• The Quick Start Guide summarizes the steps for configuring the supplier E-750 and 
printing. It also describes how to access the online documentation. 

• The User Software Installation Guide describes how to install software from the 
User Software CD to enable users to print to the supplier E-750, and also describes 
setting up printing connections to the supplier E-750.

• The Configuration Guide explains basic configuration and administration of the 
supplier E-750 for the supported platforms and network environments. It also 
includes guidelines for setting up UNIX, Windows NT 4.0/2000, and Novell 
NetWare servers to provide printing services to users. 

• The Printing Guide describes the printing features of the supplier E-750 for users 
who send jobs from their computers.

• The Color Guide provides information on managing the color output of the supplier 
E-750. It explains how to calibrate your supplier E-750 and take advantage of the 
ColorWise® color management system, as well as features in ColorWise Pro Tools™. 

• The Fiery Color Reference addresses concepts and issues associated with managing 
color output of the supplier E-750 and outlines key workflow scenarios. In addition, 
it offers information on printing color documents from popular Microsoft Windows 
and Apple Mac OS applications.

• The Job Management Guide explains the functions of the job management utilities, 
including Command WorkStation™ and DocBuilder Pro™, and how you can use 
them to monitor and control jobs on the supplier E-750. This manual is intended 
for an operator or administrator, or a user with the necessary access privileges, who 
monitors and manages job flow, performs color calibration, and troubleshoots 
problems that may arise.

• Release Notes provide last-minute product information and workarounds for some of 
the problems you may encounter.

About the 
Documentation



Copyright © 2004 Electronics for Imaging, Inc. All rights reserved. 

This publication is protected by copyright, and all rights are reserved. No part of it may be reproduced or transmitted in any form or by any means for any purpose 
without express prior written consent from Electronics for Imaging, Inc. Information in this document is subject to change without notice and does not represent 
a commitment on the part of Electronics for Imaging, Inc. 

This publication is provided in conjunction with an EFI product (the “Product”) which contains EFI software (the “Software”). The Software is furnished under 
license and may only be used or copied in accordance with the terms of the Software license set forth below. 

The Product may be covered by one or more of the following U.S. Patents: 4,917,488, 4,941,038, 5,109,241, 5,150,454, 5,150,454, 5,170,182, 5,212,546, 
5,278,599, 5,335,040, 5,343,311, 5,424,754, 5,467,446, 5,506,946, 5,517,334, 5,537,516, 5,543,940, 5,553,200, 5,565,960, 5,615,314, 5,619,624, 
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6,185,335, 6,201,614, 6,215,562, 6,219,659, 6,222,641, 6,224,048, 6,225,974, 6,226,419, 6,239,895, 6,256,108, 6,265,676, 6,266,051, 6,269,190, 
6,289,122, 6,292,177, 6,292,270, 6,300,580, 6,310,697, 6,323,893, 6,326,565, 6,327,047, 6,327,050, 6,327,052, 6,330,071, 6,331,899, 6,335,723, 
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6,449,393, 6,456,280, 6,476,927, 6,490,696, 6,501,461, 6,501,565, 6,519,053, D341,131, D406,117, D416,550, D417,864, D419,185, D426,206, 
D430,206, D439,851, D444,793, RE33,973, RE36,947

Trademarks

Bestcolor, ColorWise, EDOX, EFI, Fiery, the Fiery logo, Fiery Driven, RIP-While-Print and Spot-On are registered trademarks of Electronics For Imaging, Inc. 
in the U.S. Patent and Trademark Office and/or certain other foreign jurisdictions. 

The Best logo, the Electronics For Imaging logo, the Fiery Driven logo, the Intelligent Device Management logo, the PrintMe logo, the Splash logo, the Unimobile 
logo, the Velocity OneFlow logo, Everywhere You Go, Changing the Way the World Prints, AutoCal, AutoGray, Best, ColorCal, Command WorkStation, Device 
IQ, DocBuilder, DocBuilder Pro, DocStream, FreeForm, Fiery Link, Fiery Prints, Fiery Spark, Intelligent Device Management, NetWise, PrintMe, PrintMe 
Enterprise, PrintMe Networks, RIPChips, ScanBuilder, SendMe, Splash, Unimobile, Velocity, Velocity Balance, Velocity Build, Velocity Estimate, Velocity 
Exchange, Velocity OneFlow, Velocity Scan, VisualCal, WebInstaller, WebScan, WebSpooler, WebStatus, and WebTools are trademarks of Electronics For Imaging, 
Inc. 

All other terms and product names may be trademarks or registered trademarks of their respective owners, and are hereby acknowledged. 

Legal Notices 

APPLE COMPUTER, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. 
APPLE DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE 
RISK AS TO THE RESULTS AND PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED 
WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. 

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF 
BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE SOFTWARE EVEN IF APPLE 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. 
Apple’s liability to you for actual damages from any cause whatsoever, and regardless of the form of the action (whether in contract, tort [including negligence], 
product liability or otherwise), will be limited to $50. 

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-identified standards.þ Consult current 
PANTONE Color Publications for accurate color. PANTONE® and other Pantone, Inc. trademarks are the property of Pantone, Inc.þ © Pantone, Inc., 2003. 

Pantone, Inc. is the copyright owner of color data and/or software which are licensed to Electronics for Imaging, Inc.,þto distribute for use only in combination 
with the products, or software of Electronics for Imaging, Inc. þPANTONE Color Data and/or Software shall not be copied onto another disk or into memory 
except as part of the delivery of the Electronics for Imaging, Inc., products or software.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).
Part Number: 45040192



FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

Class A Compliance

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, and uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause interference in which case the user will be required to correct the interference 
at his own expense. 

Industry Canada Class A Notice

This Class A digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe A de l’Industrie Canada 

Cet appareil numérique de la Classe A est conforme à la norme NMB-003 du Canada.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstörbestimmungen 
geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen bei anderen Gerätekombinationen nicht eingehalten werden. 
Für die Einhaltung der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung richtiger Ausführungen ist der 
Betreiber verantwortlich.



Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE 
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT 
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE. 

License

EFI grants you a non-exclusive license to use the Software and accompanying documentation (“Documentation”) included with the Product. The Software is 
licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend the Software 
or use the Software in any time sharing, service bureau, or similar arrangement. 

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) copy for backup or archive purposes in 
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to localize, translate, disassemble, 
decompile, decrypt, reverse engineer, discover the source code of, modify, create derivative works of, or in any way change any part of the Software.

The terms, conditions, and restrictions in the License Agreement apply to all bug fixes, patches, releases, release notes, updates, and upgrades related to the 
Software.

Proprietary Rights

You acknowledge and agree that all rights, title and interest, including all intellectual property rights, in and relating to the Software, Documentation and all 
modifications and derivative works thereof are solely owned by and shall remain with EFI and its suppliers. Except for the express limited license granted above to 
use the Software, no right or license of any kind is granted. You receive no rights or license under any patents, copyrights, trade secrets, or trademarks (whether 
registered or unregistered). You agree not to adopt, register, or attempt to register any EFI trademark or trade name (“EFI Mark”) or any confusingly similar mark, 
URL, internet domain name, or symbol as your own name or the name of your affiliates or products, and not to take any other action which impairs or reduces 
the trademark rights of EFI or its suppliers. 

Confidentiality

The Software is confidential, proprietary information of EFI and you may not distribute or disclose the Software. You may, however, permanently transfer all of 
your rights under this Agreement to another person or legal entity provided that: (1) such a transfer is authorized under all applicable export laws and regulations, 
including the U.S. Export Administration Regulations, (2) you transfer to the person or entity all of the Software and Documentation (including all copies, 
updates, upgrades, prior versions, component parts, the media and printed materials, and this Agreement); (3) you retain no copies of the Software and 
Documentation, including copies stored on a computer; and (4) the recipient agrees to the terms and conditions of this Agreement. 

Remedies and Termination

Unauthorized use, copying, or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make available 
to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software, Documentation, and all component parts thereof. All 
provisions of this Agreement relating to disclaimers of warranties, limitation of liability, remedies, damages, governing law, jurisdiction, venue, and EFI’s 
proprietary rights shall survive termination.

Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software 
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted, secure, fault-tolerant, or error free, or that all defects in the Software will be corrected. EFI makes no 
warranty, implied or otherwise, regarding the performance or reliability of any third party products (software or hardware. THE INSTALLATION OF ANY 
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION, 
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EFI 
MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY 
OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF THIRD 
PARTY RIGHTS. 



Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this agreement to the extent that this agreement contains provisions which relate to your use of any software, font programs, typefaces, and/or 
trademarks licensed or supplied by Adobe. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to EFI. ADOBE 
WILL HAVE NO LIABILITY WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE OR TECHNOLOGY LICENSED HEREUNDER.

Export Controls

EFI’s Products are subject to U.S. export laws and regulations, including the U.S. Export Administration Regulations, as well as foreign export laws and regulations. 
You agree that you will not use, distribute, transfer, export, or re-export any portion of the Product or the Software in any form in violation of any applicable laws 
or regulations of the United States or the country in which you obtained them.

U.S. Government Restricted Rights:

Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set forth in FAR 12.212 or DFARS 227.7202-3 -
227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights as set out in FAR 52.227-14, Restricted Rights Notice (June 1987) 
Alternate III(g)(3)(June 1987) or FAR 52.227-19 (June 1987). To the extent any technical data is provided pursuant to the Agreement, such data is protected per 
FAR 12.211 and DFARS 227.7102-2 and to the extent explicitly required by the U.S. Government, is subject to limited rights as set out in DFARS 252.227.7015 
(November 1995) and DFARS 252.227-7037 (September 1999). In the event that any of the above referenced agency regulations are modified or superceded, the 
subsequent or equivalent regulation shall apply. The name of the Contractor is Electronics for Imaging. 

General

The rights and obligations of the parties related to this Agreement will be governed in all respects by the laws of the State of California exclusively, as such laws 
apply to contracts between California residents performed entirely within California. The United Nations Convention on Contracts for the International Sale of 
Goods and any other similar convention does not apply to this Agreement. For all disputes related to this Agreement, you consent to the personal and exclusive 
jurisdiction and venue of the state courts in San Mateo County, California and the federal court for the Northern District of California. This Agreement is the 
entire agreement held between us and supersedes any other communications or advertising with respect to the Software. If any provision of this Agreement is held 
invalid, such provision shall be deemed modified to the extent necessary to be enforceable and the other provisions in this Agreement shall continue in full force 
and effect.

If you have any questions, please see EFI’s web site at www.efi.com.

Electronics for Imaging 
303 Velocity Way 
Foster City, CA 94404
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xi About this manual
This manual describes how to install user software for the supplier E-750, and how 
to set up printing from Microsoft Windows and Apple Mac OS computers. For 
information about setting up network servers and clients to use the supplier E-750, 
see the Configuration Guide. For general information on using the color copier/
printer, your computer, application software, or network, see the manuals that 
accompany those products.

NOTE: The term “E-750” is used to refer to the supplier E-750. The term “copier/
printer” is used to refer to the machine. The term “Windows” is used to refer to 
Windows 98, Windows Me, Windows NT 4.0, Windows 2000, Windows XP, and 
Windows Server 2003, wherever appropriate.

The E-750 includes support for Fiery WebTools™ and software for Command 
WorkStation, which enables an operator to manage all jobs sent to the E-750. 
Although it may not be the case at all sites, the documentation for this product 
assumes the presence of an operator who controls and manages jobs sent by users 
from remote workstations.

About this manual
This manual covers the following topics:

• Installing printer files on Windows and Mac OS computers

• Setting up printing connections on Windows and Mac OS computers

• Installing Fiery® utilities/other user software on Windows and Mac OS computers

Introduction



xii Introduction
Specifications
• Intel Mobile Pentium III 850 MHz CPU

• 256MB (Max.512MB) RAM

• 10GB hard disk drive (minimum)

• Supports AppleTalk, TCP/IP, and IPX/SPX protocols simultaneously

• Supports Port 9100

• Supports twisted pair (Fast Ethernet 100BaseTX or Ethernet 10BaseT)

• Supports Adobe PostScript 3

• Supports PCL 6ec printing (for Windows computers)

In addition, two Adobe Multiple Master fonts are included and are used for font 
substitution in PDF files.

• Includes 81 scalable PCL fonts

• Built-in ColorWise color management and NetWise™ networking management

• Fiery WebTools, including WebSetup™ (Windows only), Status™, WebLink™, 
Installer™, WebDownloader™, and WebScan™

• Fiery utilities, including Fiery Downloader™, Fiery Mail Port™, and Fiery Spooler™ 
(Mac OS only)

• Fiery Remote Scan™

• ColorWise Pro Tools

• Command WorkStation (Windows only) software

• Command WorkStation LE (Mac OS X Native only) software

• Supports Internet Printing Protocol (IPP) for Windows Me, and Windows 2000/
XP/Server 2003

• Supports E-mail printing

• Supports PrintMe™ (available as an option)



xiii User software
User software
E-750 user software is provided on the User Software CD.  

Adobe PostScript 
Printer Driver

Enables you to print to the E-750 from  
Windows 98/Me, Windows NT 4.0, and Mac OS 
computers; also supports E-750 and PostScript 3 
features. Windows 2000/XP/Server 2003 users should 
use the PostScript Printer Driver provided with those 
operating systems.

PostScript Printer 
Description (PPD) file 

For use with the PostScript printer driver that allows 
the E-750 to appear in the Print and Page Setup dialog 
boxes of popular applications. The E-750 PPDs 
provide information about the E-750 and your 
particular copier/printer model to the application and 
printer driver you are using.

PostScript fonts 
(Mac OS only) 

PostScript screen and printer fonts that correspond 
to the PostScript printer fonts installed on the E-750. 
For a complete list of PostScript fonts installed on the 
E-750, see Appendix B of the Printing Guide. 

PCL Printer Driver 
(Windows only)

Enables you to print to the E-750 from Windows com-
puters; supports E-750 PCL print features. 

PCL PDD file For use with the PCL printer driver that enables the 
E-750 to appear in Print and Page Setup dialog boxes 
in popular applications. The E-750 PDDs provide 
information about the E-750 and your particular 
copier/printer model to the application and printer 
driver you are using.

Fiery Downloader Enables you to print PostScript files, PCL files, 
Encapsulated PostScript (EPS) files, TIFF version 6.0 
files, and Portable Document Format (PDF) versions 
1.2 and 1.3 files directly to the E-750 without opening 
the application in which they were created. You can 
also use it to manage the printer fonts installed on the 
E-750.



xiv Introduction
Fiery Spooler 
(Mac OS 9.x only)

Enables you to view the order and priority of print 
jobs, customize printer settings for jobs, delete jobs, 
and move jobs between queues. You can also use it to 
view job accounting information.

ColorWise Pro Tools ICC-open color management; enables you to edit and 
download ICC profiles.

Command WorkStation 
(Windows only)

Enables the operator to control the E-750 functions 
from Windows 98/Me and Windows NT/2000/XP 
computers. To use Command WorkStation, see the Job 
Management Guide.

Command WorkStation LE 
(Mac OS X Native 
Mode only)

Enables the operator to control E-750 functions from 
Mac OS X (10.2.x) Native Mode computers. To use 
Command WorkStation LE, see the 
Job Management Guide.

EFI Fiery Mail Port 
(Windows only)

Enables you to send jobs to the E-750 in the form of 
e-mail attachments by adding the EFI Fiery Mail Port 
software as a printer port.

Color management files ICM (Windows) and ColorSync (Mac OS) color 
management files that enable you to maintain 
consistent color from your original artwork to the 
colors displayed on your monitor and then to the 
printed output.

Color reference files Reference pages that you can print to view the range of 
colors available on your E-750. For the most 
predictable color results, refer to these pages when 
defining colors in applications. For more information 
on color management, see the Color Guide.

MRJ (Mac OS 9.x only) Mac OS Runtime for Java (MRJ) is required by all 
Java-based Fiery utilities. If MRJ is not detected when 
you install these utilities, the MRJ installer is 
automatically launched.



xv User software
NOTE: You can install PostScript and PCL printer drivers and printer description files 
from the User Software CD or from the E-750 with the Installer WebTool. 
For instructions, see  “Using the Fiery WebTools Installer” on page 3-2.



xvi Introduction
Fiery WebTools
Fiery WebTools allow you to manage your E-750 remotely from the Internet or from 
your company’s intranet. You access Fiery WebTools from the Fiery WebTools home 
page.

NOTE: To find out which Fiery WebTools are supported, see “Specifications” on 
page xii.

System requirements
System requirements are described in detail in the printed Quick Start Guide provided 
in your media pack.

Fiery WebTools Summary For more information

Status Shows you the jobs currently processing 
and printing.

See the Printing Guide.

WebLink Provides a link to another web page, 
provided you have a valid Internet 
connection.

See the Printing Guide and 
the Configuration Guide.

Installer Allows you to download E-750 printer 
file installers directly from the server.

See Chapter 3.

WebDownloader Allows you to download PostScript, 
PCL, EPS, and PDF files to the E-750.

See the Printing Guide.

WebSetup 
(Windows only)

Allows you to modify the E-750 
configuration (Setup) remotely. This 
function requires the Administrator 
password, if one has been set.

See the Configuration Guide.

WebScan Allows you to view and print images that 
have been scanned to the copier/printer.

See the Printing Guide.



11-1 Setting up PostScript or PCL printing with Windows 98/Me
This chapter describes the procedures for installing software and setting up printing 
from a computer using a supported version of Windows. For the Windows versions 
supported, see the Quick Start Guide. 

The general steps for installing the software are as follows: 

• Install the PostScript printer driver or PCL printer driver and corresponding printer 
driver files and set up the printer driver to communicate with the E-750.

• Install Fiery utilities and user software—Fiery Remote Scan, Fiery Downloader, 
Fiery Printer Delete Utility, ColorWise Pro Tools, and Command WorkStation.

• Install Adobe Acrobat and PitStop for use with DocBuilder Pro.

• Configure the connection for Fiery utilities and user software.

• Copy additional files from the User Software CD as required.

In addition to using the User Software CD, you can download printer drivers from the 
E-750 with the Installer WebTool (if the administrator has enabled Internet access to 
the E-750). For instructions, see “Using the Fiery WebTools Installer” on page 3-2. 
Once you download the printer files, the installation process is identical to installing 
from the User Software CD.

Setting up PostScript or PCL printing with 
Windows 98/Me
To set up the E-750 as a PostScript or PCL printer, you must install the PostScript or 
PCL printer driver for Windows 98/Me and the corresponding printer description 
files. You must also configure either a local connection for printing directly or a 
network connection for printing over the network. 

If you are printing using SMB (Server Message Block), you can connect to the E-750 
and install the printer drivers in a single procedure. For more information, see “Setting 
up SMB printing with Windows 98/Me” on page 1-10.

Chapter 1:
Installing 
User Software 
on a Windows 
Computer
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NOTE: The procedures for setting up printing with the PostScript and PCL printer 
drivers are similar. The following illustrations show the PostScript drivers. Any 
differences are noted.

Installing the PostScript or PCL printer driver for 
Windows 98/Me

NOTE: The following procedures display Windows 98 illustrations; Me differences are 
noted.

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER  
FOR WINDOWS 98/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, double-click the Add Printer icon and click Next.

3. Specify printing using a Local printer and click Next.

This procedure describes the installation of a local printer. You can modify the 
connection later, according to your network type.

4. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.

5. If you are installing from the CD, type the name of the CD-ROM drive (for example, 
D:\), and click Browse. Browse to English \Prntdrvr\Ps_drvr\Win_9x_ME. 

If you are installing from the files you downloaded using the Installer WebTool, 
browse to prntdrvr\Prntdrvr\Ps_drvr\Win_9x_ME.

6. Make sure “Oemsetup.inf” is selected and click OK. 

The path is copied to the Install From Disk dialog box.

7. Verify the path is correct and click OK.
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8. Select the E-750 printer driver appropriate for your printer and click Next.

NOTE: Use E-750 EU PS when A4 is the default paper size. Use E-750 US PS when 
Letter is the default paper size.

9. Select the LPT1 port and click Next.

You will configure the port later, according to your network type.

10. Enter a name for the E-750.

11. To make the E-750 the default printer, select Yes; if not, select No and click Next.

12. Select No to printing the test page and click Finish.

The necessary PostScript or PCL files are installed to your computer.

Configuring installed options
After you have completed the printer driver installation, you must configure the E-750 
for the options installed on the copier/printer. This allows the E-750 to take advantage 
of the copier/printer options. You can configure the options manually. Or, for TCP/IP 
network connections, you can use the Two-Way Communication feature to configure 
the options automatically.
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Configuring installed options manually

The following procedure describes how to manually configure the E-750 for the 
options installed on the copier/printer.

TO CONFIGURE OPTIONS MANUALLY FOR WINDOWS 98/ME

1. Click Start, choose Settings, and then choose Printers.

2. Click the E-750 icon and choose Properties from the File menu. 

3. Click the Configuration tab.

4. Select an installed option from the Available Options list.

5. Click Add to move the option to the Installed Options list.

Copier Type—Color-MFPe, Color-MFPe-ADU

Punch Option—Not Installed, 2 hole Punch Unit, 2/3 hole Punch Unit, 4 hole Punch 
Unit (F), 4 hole Punch Unit (S)

NOTE: Select 2/3 hole Punch Unit to use the Punch Option.

Sorter and Stapler—Not Installed, Finisher with Saddle Stitcher, Finisher with Stapler
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Large Capacity Feeder—Not Installed, Installed

Auto Trapping—Not Installed, Installed

NOTE: The Auto Trapping option is not available with the PCL printer driver.

6. Click Apply, and then click OK.

Configuring installed options and updating print options settings 
automatically

If you have a TCP/IP-enabled network, you can automatically update your printer 
driver to reflect the options currently installed on the copier/printer. When the printer 
driver is first installed, the options have default settings that were set up in E-750 Setup 
or ColorWise Pro Tools. When you update the printer driver with the Two-Way 
Communication feature, you allow the E-750 to complete the actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to 
reflect the current color settings on the E-750. To access the Expert Color Settings 
options, click the Expert Settings tab in the ColorWise print option bar of the Fiery 
printing tab of your printer driver. For more information, see the Color Guide.

TO CONFIGURE INSTALLED OPTIONS AND UPDATE PRINT OPTIONS 
SETTINGS AUTOMATICALLY FOR WINDOWS 98/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, select the icon for the E-750 PostScript or PCL  
printer driver. 

3. Choose Properties from the File menu.

4. Click the Configuration tab.
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5. Select Two-Way Communication.

6. Type the E-750 IP address or DNS name.

7. To display the printer’s current default settings when opened, select Update Fiery 
Driver When Opened.

8. Click Update.

9. To receive an e-mail notification after your job has been printed, select Enable E-mail 
Notification, and type in the e-mail address to which an e-mail notification is sent.

You will also receive e-mail notification of any errors that occur during printing.

NOTE: Enable E-mail Notification is displayed only if E-mail Service is enabled at 
Setup.

10. Click OK.

Completing the Windows 98/Me printer connection
To print from Windows 98/Me, you should already have set up network servers, if any, 
and set up the E-750 to accept print jobs from your computer.
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To complete the Windows 98/Me connection, you must configure a connection on 
each Windows computer for the network.

Completing the Windows 98/Me IPX/SPX or IPX (Novell) connection

If you are printing through a Novell server, the Novell network and file server should 
be set up before you begin. The file server should be configured with a print server and 
print connection for the E-750. For details, see your NetWare documentation and the 
Configuration Guide.

To print from Windows 98/Me computers over IPX (Novell), you must first set up 
IPX/SPX protocols, and then configure the E-750 by choosing the IPX frame type and 
entering the settings for the port you use.

TO SELECT A FRAME TYPE FOR IPX/SPX PRINTING 
FOR WINDOWS 98/ME

1. Click Start, choose Settings, and then choose Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol is listed in the installed network 
components pane.

For instructions, see your Windows 98/Me documentation or contact Microsoft 
Technical Support.
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3. Double-click the IPX/SPX-compatible Protocol icon.

4. Click the Advanced tab.

5. Select Frame Type in the Property list. 

6. In the Value menu, choose the Frame Type that corresponds to the one set in E-750 
Network Setup.

If necessary, print the Configuration page from the E-750 Control Panel to determine 
which frame type(s) are configured.
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NOTE: Do not select Auto. Auto may not select the frame type specified on the E-750.

7. Click OK and close the Network Control Panel.

8. When prompted to restart your computer, click Yes.

TO SET UP A PORT FOR IPX (NOVELL) PRINTING WITH WINDOWS 98/ME

1. Click Start, choose Settings, and then choose Printers.

2. Click the E-750 printer icon and choose Properties from the File menu.

3. Click the Details tab and click Add Port.

A list of connection options appears.

4. In the Add Port dialog box, specify the network path or click Browse for a display of 
your network environment.

5. If you are using a NetWare file server, double-click the icon for the NetWare file server 
to use for printing to the E-750. 
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6. Click the printer icon for the NetWare print queue you want to use, and then click OK.

7. In the Add Port dialog box, verify that the network path is updated and click OK.

Your print jobs are transmitted to the specified print queue on the Novell file server. 
The E-750 polls the file server, and if jobs are present, they are transmitted to 
the E-750.

8. To confirm the connection, click the General tab, click Apply, and then click Print 
Test Page.

After the test page prints successfully, you are ready to print from the computer.

Setting up SMB printing with Windows 98/Me

SMB printing (also known as Windows or WINS printing) allows you to install the 
PostScript or PCL printer driver and printer description files on your computer from 
the E-750 using Point and Print, and print to a particular connection (Hold, Print, or 
Direct). To set up SMB printing, you must have the TCP/IP protocol and Client for 
Microsoft Networks installed.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer 
description file. Repeat the procedure “To set up SMB printing on Windows 98/Me” 
for each connection. If you install more than one printer, give each a descriptive name 
during printer driver installation, such as E-750-Print or E-750-Hold, so you can easily 
identify printers.

BEFORE YOU BEGIN

• Configure the E-750 for SMB printing in Run Setup > Network Setup > Service 
Setup  >  Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. 
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TO SET UP SMB PRINTING ON WINDOWS 98/ME

1. Double-click the Network Neighborhood icon to display your network environment.

2. Browse for the printer you want to print to.

Browse for the name entered in Network Setup >  Service Setup >  Windows 
Setup > Server Name.  For this information, see the Configuration page.

NOTE: You can also locate the printer using the Find feature on your Windows 
computer. Click Start, choose Find, and then choose  Computer. Enter the name of the 
printer, and click Find Now.

If you are not able to locate your E-750, contact your network administrator.

3. Double-click the name of the printer to display enabled print connections.

NOTE: For a description of each print connection, see the Configuration Guide.

4. Double-click the name of the connection you want to print to.

5. Select Yes to install the PostScript or PCL printer driver and printer description file for 
the selected connection.

The Add Printer Wizard dialog box appears.

6. Specify whether you print from MS-DOS based programs and click Next.

If you choose Yes, you must capture a printer port before proceeding with the 
installation. For details, see your Windows documentation.
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7. Type a name for the E-750 in the Printer name field and choose whether to make it 
the default printer. Click Next.

8. To print a test page, choose Yes and click Finish.

The necessary files are installed to your computer. 

If the test page prints successfully, you are ready to print from the computer.

Setting up IPP printing with Windows 98/Me

With Internet Printing Protocol (IPP), print jobs are sent to the E-750 over 
the Internet.

IPP printing is supported on Windows 2000/XP/Server 2003but can be enabled on 
Windows 98/Me computers by installing the wpnpins.exe client file (available on the 
Windows Me CD or the Windows 2000 Server CD). For more information about 
obtaining and installing this client, contact the Microsoft Corporation or Microsoft 
Technical Support.

NOTE: The IPP setup procedures are performed after installing the appropriate printer 
drivers. See “To install the PostScript or PCL printer driver for Windows 98/Me” on 
page 1-2.

BEFORE YOU BEGIN

1. Prepare the E-750 for TCP/IP printing.

2. Make sure the E-750 is configured for IPP printing. 

For more information, see the Configuration Guide.

3. Specify the printing destination on your computer.

TO SET UP IPP PRINTING WITH WINDOWS 98/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers windows, right-click the icon for the E-750 PostScript printer driver 
and choose Properties.

3. Click the Details tab and click Add Port.

The Add Port dialog box appears.



11-13 Setting up PostScript or PCL printing with Windows NT 4.0
4. Enter the network path for the printer.

5. Click OK. 

Setting up PostScript or PCL printing 
with Windows NT 4.0
To set up the E-750 as a PostScript or PCL printer, you must install the PostScript or 
PCL printer driver for Windows NT 4.0 and the corresponding printer description 
files. You must also configure the print connection between the computer and the 
E-750. If you are printing over a network, you must configure a network connection.

NOTE: The procedures for setting up printing with the PostScript and PCL printer 
drivers are similar. The following illustrations show the PostScript driver. Any 
differences are noted.

Installing the PostScript or PCL printer driver 
for Windows NT 4.0

The following procedures describe the installation of a local printer. Adding a printer 
to a local system requires that you log in to your local Windows NT 4.0 computer 
(not the network server domain) and that you are a member of the Administrators 
group. The procedure for adding a network printer is similar to adding a port. See 
“Completing the Windows NT 4.0 TCP/IP and LPR connection” on page 1-21.

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER 
FOR WINDOWS NT 4.0

1. If you are installing from the User Software CD, insert it into the CD-ROM drive.

2. Click Start, choose Settings, and then choose Printers.

3. Double-click Add Printer.

4. To install a printer locally, select My Computer and click Next.

My Computer is available if you logged in to a computer on which you have 
Administrator privileges. If it is not available, you can add a network printer. 
The procedure is similar to adding a port (see page 1-22).
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5. Select LPT1: and click Next.

This is a general installation that works for the parallel port connection. You can add 
a network port later, according to your network type.

6. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.

7. If you are installing from the CD, type the name of the CD-ROM drive (for example, 
D:\) and click Browse.

If you are installing from files you downloaded using the Installer WebTool, type the 
name of your hard disk drive (for example, C:\) and click Browse.

8. If you are installing from the CD, browse to the English \Prntdrvr\Ps_drvr\Win_NT4x 
folder and click Open.

If you are installing from files you downloaded using the Installer WebTool, browse to 
the prntdrvr\Prntdrvr\Ps_drvr\Win_NT4x folder and click Open.

Make sure “Oemsetup.inf” or “Oemsetup” is selected.

The path is copied to the Install From Disk dialog box.
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9. Verify that the path is correct and click OK.

10. In the Printers list, select the E-750 printer driver appropriate for your printer and 
click Next.

NOTE: Use E-750 EU PS when A4 is the default paper size. Use E-750 US PS when 
Letter is the default paper size.

11. Type a name for the E-750 in the Printer name field and indicate whether you want to 
make it the default printer. Click Next.

12. Indicate whether you want the printer installed as a shared printer, and click Next.

If you select Shared, enter a Share Name for the printer and select the operating 
systems used by client computers. For information on shared printers, see the 
Configuration Guide.

13. Click No to postpone printing a test page and click Finish.
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When installation is complete, the Printers window is displayed with an icon for the 
newly installed printer.

Configuring installed options
After you have completed the printer driver installation, you must configure the E-750 
to reflect the options installed on the copier/printer. This allows the E-750 to take 
advantage of the copier/printer options. You can configure the options manually; or 
for TCP/IP network connections, you can use the Two-Way Communication feature 
to configure the options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the E-750 for the 
options installed on the copier/printer.

TO CONFIGURE INSTALLABLE OPTIONS FROM THE POSTSCRIPT PRINTER DRIVER 
FOR WINDOWS NT 4.0

1. Click Start, choose Settings, and then choose Printers. 

2. Right-click the E-750 icon and choose Properties.

3. Click the Configuration tab.

4. Select an installed option from the Available Options list.
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5. Click Add to move the option to the Installed Options list.

Copier Type—Color-MFPe, Color-MFPe-ADU

Punch Option—Not Installed, 2 hole Punch Unit, 2/3 hole Punch Unit, 4 hole Punch 
Unit (F), 4 hole Punch Unit (S)

NOTE: Select 2/3 hole Punch Unit to use the Punch Option.

Sorter and Stapler—Not Installed, Finisher with Saddle Stitcher, Finisher with Stapler

Large Capacity Feeder—Not Installed, Installed

Auto Trapping—Not Installed, Installed

NOTE: The Auto Trapping option is not available with the PCL printer driver.

6. Click OK to activate the current settings.
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TO CONFIGURE INSTALLABLE OPTIONS ON THE E-750 FROM 
THE PCL PRINTER DRIVER

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the E-750 icon, and choose Document Defaults from the File menu.

3. Click the Configuration tab and specify the options installed on the E-750.

4. Select an installed option from the Available Options list, and click Add to move the 
option to the Installed Options list. 

Copier Type—Color-MFPe, Color-MFPe-ADU

Punch Option—Not Installed, 2 hole Punch Unit, 2/3 hole Punch Unit, 4 hole Punch 
Unit (F), 4 hole Punch Unit (S)

NOTE: Select 2/3 hole Punch Unit to use the Punch Option.

Sorter and Stapler—Not Installed, Finisher with Saddle Stitcher, Finisher with Stapler

Large Capacity Feeder—Not Installed, Installed

Auto Trapping—Not Installed, Installed

5. Click OK.

You are ready to connect to your network type (see “Completing the Windows NT 4.0 
printer connection” on page 1-21).
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Configuring installed options and updating print options settings 
automatically

If you have a TCP/IP-enabled network, you can automatically update your printer 
driver to reflect the options currently installed on the E-750. When the printer driver 
is first installed, the installable options have default settings that were set up in 
E-750 Setup or ColorWise Pro Tools. When you update the printer driver with the 
Two-Way Communication feature, you allow the E-750 to complete the actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to 
reflect the current color settings on the E-750. To access Expert Color Settings options, 
click the Expert Settings tab in the ColorWise print option bar of the Fiery printing 
tab of your printer driver. For more information, see the Color Guide.

TO SET UP TWO-WAY COMMUNICATION FOR POSTSCRIPT OR 
PCL PRINTER DRIVERS FOR WINDOWS NT 4.0

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, select the icon for the E-750 PostScript or PCL  
printer driver. 

3. Choose Properties from the File menu.

4. Click the Configuration tab.

NOTE: The following illustration shows the PostScript printer driver. The PCL printer 
driver is similar except for the tabs and the title bar.
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5. Select Two-Way Communication.

6. Enter the E-750 IP address or DNS name.

7. If you want your printer driver to display the current settings when opened, select 
Update Fiery Driver When Opened.

8. Click Update.

9. To receive an e-mail notification after your job has been printed, select Enable E-mail 
Notification, and type in the e-mail address to which an e-mail notification is sent.

You will also receive e-mail notification of any errors that occur during printing.

NOTE: Enable E-mail Notification is displayed only if E-mail Service is enabled at 
Setup.

10. Click OK.
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Completing the Windows NT 4.0 printer connection
To print from Windows NT 4.0, you must:

• Set up network servers, if any.

• Set up the E-750 to accept print jobs from your computer.

• Configure a port on each Windows NT 4.0 computer for the network type.

Completing the Windows NT 4.0 TCP/IP and LPR connection

After installing the PostScript or PCL printer driver and printer driver files, complete 
the setup for the TCP/IP and LPR connection by performing the following steps:

• Prepare the E-750 to accept print jobs using TCP/IP and LPR protocols. 
For details, see the Configuration Guide.

• Enable LPD from the E-750 Control Panel. For details, see the Configuration Guide.

• Configure the computer for the TCP/IP connection.

Before you continue, contact the system administrator for the IP address assigned to 
the E-750, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP protocol should already be installed on your Windows NT computer.

To do this See

Configure the TCP/IP (LPR port) 
connection

“Completing the Windows NT 4.0 TCP/IP 
and LPR connection” on page 1-21.

Configure the IPX (Novell) connection “Completing the Windows NT 4.0 IPX 
(Novell) connection” on page 1-24.
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TO SET UP TCP/IP AND LPR PRINTING FOR WINDOWS NT 4.0

1. Open the Properties dialog box for the E-750 and click the Ports tab.

2. Click Add Port.

The available port types are displayed.

3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP network protocol and 
Microsoft TCP/IP printing software. See your Windows documentation.

4. Type the IP address of the E-750. 

If your network uses Domain Name Services (DNS), enter the DNS name assigned to 
the E-750 instead of the IP address.

5. Type one of the following printer names, depending on the E-750 connection you want 
to print to.

print 
hold
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6. Click OK.

The computer checks the address or DNS name you entered and notifies you if it 
cannot resolve the address.

7. Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You must close the Printer 
Properties dialog box to verify the connection. 

8. Click OK to close the Printer Properties dialog box. 

9. Reopen the Printer Properties dialog box.

10. Click the General tab and click Print Test Page.

When you print, your PostScript or PCL files are transmitted over the LPR Port 
connection to the E-750.

11. Click OK to close the Printer Properties dialog box.
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Completing the Windows NT 4.0 IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling E-750 print jobs. The file 
server should be configured with a print server and print connection for the E-750. 
For details, see your NetWare documentation.

• Prepare the E-750 for IPX printing.

• Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 
services should already be installed on the Windows NT 4.0 computer.

TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS NT 4.0

1. Double-click Network Neighborhood.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

3. Double-click the NetWare Tree or File Server on which the network administrator 
defined a print connection for the E-750.

You may have to log in to the file server to see the print connections.

4. Double-click the print connection defined for the E-750.
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5. If the NetWare server does not have a suitable driver for the E-750, you may be asked 
if you want to set up the printer on your computer. Click Yes.

6. Click OK to install the E-750 PostScript printer driver.

7. Follow steps 6 to 13 of the procedure on page 1-14.

When installation is complete, a new printer window appears, with the name of the 
print queue on the NetWare server.

8. Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for 
the E-750.

9. Click the General tab and click Print Test Page.

10. In the printer Job Notes window, type user and job identification information and 
click OK.

The Test Page remains listed in the queue window until it is printed.

The E-750 polls the NetWare server for print jobs in the print connection defined for 
the E-750. When you print, your PostScript files are spooled to that connection and 
transmitted over the queue “port” to the E-750. 
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Setting up SMB printing on Windows NT 4.0

SMB printing (also known as Windows printing) allows you to install the PostScript or 
PCL printer driver and printer description files, and print from your computer to a 
particular print connection (Hold, Print, or Direct) on the E-750. These instructions 
assume you have installed the TCP/IP protocol and Client for Microsoft Networks.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer 
description file. To set up printing to a second or third print connection, repeat the 
procedure “To set up SMB printing on Windows NT 4.0” on page 1-27. If you install 
more than one printer, give each a descriptive name during printer driver installation, 
such as E-750-Print or E-750-Hold, so you can easily identify printers.

NOTE: To change printer defaults and configure installable options from Windows 
NT 4.0, you must log on with the special log-in name, ‘efi_admin_efi’ (instead of 
Administrator) and use the password specified in E-750 Setup. If you log on as a User, 
you can install the printer driver through Point and Print, but you cannot modify 
printer defaults and configure installable options.

BEFORE YOU BEGIN

• Configure the E-750 for SMB printing in Run Setup > Network Setup > Service 
Setup >  Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. For more information, see the Configuration Guide.
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TO SET UP SMB PRINTING ON WINDOWS NT 4.0

1. Double-click Network Neighborhood.

2. Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in Network 
Setup > Service Setup  > Windows Setup > Server Name. For this information, see the 
Configuration page.

The amount of network traffic determines the amount of time required for the 
Browse function.

NOTE: You can also locate the printer with the Find feature on your Windows 
computer. Click Start , choose Find, and then choose  Computer. Enter the name of the 
printer, and click Find Now.

If you are not able to locate your E-750, contact your network administrator.

3. Double-click the name of the E-750 to display enabled print connections.
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4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you want to set up the printer.

5. Select Yes to complete the installation for the selected connection.

Windows NT 4.0 downloads the printer driver and printer description files from the 
E-750 to your computer and installation is complete.

Setting up PostScript or PCL printing with 
Windows 2000/XP/Server 2003
NOTE: To set up the E-750 as a PostScript or PCL printer, you must install the 
PostScript or PCL printer driver for Windows 2000/XP/Server 2003 and the 
corresponding printer description files. You must also configure the print connection 
between the computer and the E-750. If you are printing over a network, you must 
configure a network connection.For Windows Server 2003, use the 
Windows 2000/XP printer driver.

NOTE: The procedures for configuring the options for the PostScript and PCL printer 
drivers are similar. The following illustrations show the PostScript driver. Differences 
are noted.

Installing the PostScript or PCL printer driver 
for Windows 2000/XP

If you are upgrading from an earlier version of the software, use the Fiery Printer 
Delete Utility to remove old printer drivers. For details, see “Installing Fiery utilities” 
on page 1-53 and “To use Fiery Printer Delete Utility” on page 1-56.



11-29 Setting up PostScript or PCL printing with Windows 2000/XP/Server 2003
TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER  
FOR WINDOWS 2000/XP/SERVER 2003

1. On Windows 2000, click Start, choose Settings, and then choose Printers to display the 
Printers window. 

On Windows XP/Server 2003, click Start and choose Printer and Faxes.

2. On Windows 2000, double-click the Add Printer icon and click Next.

On Windows XP/Server 2003, click Add Printer.

3. Specify printing using a Local printer and click Next.

This procedure describes the installation of a local printer. You can modify the 
connection later, according to your network type.

4. Select LPT1: and click Next.

5. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.
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6. Type the name of the CD-ROM drive (for example, D:\) and click Browse. Browse to the 
English \Prntdrvr\Ps_drvr\Win_2K_XP folder.

If you are installing from the files you downloaded using the Installer, browse to 
prntdrvr\Prntdrvr\Ps_drvr\Win_2K_XP and click Open.

Make sure “Oemsetup.inf” or “Oemsetup” is selected and click Open. 

7. Verify the path is correct and click OK.

The path is copied to the Install From Disk dialog box.

8. In the Printers box, select the E-750 printer driver appropriate for your printer and 
click Next.
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NOTE: Use E-750 EU PS when A4 is the default paper size. Use E-750 US PS when 
Letter is the default paper size.

9. Type a name for the E-750 in the Printer name field.

This name will be used in the Printers window and the queues window.

10. Follow the instructions in the remaining dialog boxes.

When asked whether to print a test page, select No.

The necessary files are installed to your hard disk.

NOTE: The Digital Signature Not Found dialog box indicates that the printer driver for 
Windows 2000 does not have a Microsoft digital signature. However, printing to the 
E-750 is processed correctly, so click Yes to continue with installation.

11. If this is the first printer driver you are installing on the computer, you may be 
prompted to install files from the Windows 2000 CD. Insert the CD-ROM, browse to the 
win2000\english\i386 folder, and then click OK.

When installation is complete, the Printers window appears with an icon for the newly 
installed printer. You must now configure the options installed on your copier/printer.
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Configuring installed options
After you have completed the printer driver installation, you must configure the E-750 
to reflect the options installed on the copier/printer. This allows the E-750 to take 
advantage of the copier/printer options. You can configure the options manually; or 
for TCP/IP network connections, you can use the Two-Way Communication feature 
to configure the options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the E-750 for the 
options installed on the copier/printer.

TO CONFIGURE INSTALLABLE OPTIONS ON THE E-750 FROM THE POSTSCRIPT 
PRINTER DRIVER FOR WINDOWS 2000/XP/SERVER 2003

1. On Windows 2000, click Start, choose Settings, and then choose Printers. 

On Windows XP, click Start, and choose Printers and Faxes.

2. Right-click the E-750 icon and choose Properties.

3. Click the Configuration tab.

4. Select an installed option from the Available Options list.
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5. Click Add to move the option to the Installed Options list.
.

Copier Type—Color-MFPe, Color-MFPe-ADU

Punch Option—Not Installed, 2 hole Punch Unit, 2/3 hole Punch Unit, 4 hole Punch 
Unit (F), 4 hole Punch Unit (S)

NOTE: Select 2/3 hole Punch Unit to use the Punch Option.

Sorter and Stapler—Not Installed, Finisher with Saddle Stitcher, Finisher with Stapler

Large Capacity Feeder—Not Installed, Installed

Auto Trapping—Not Installed, Installed

NOTE: The Auto Trapping option is not available with the PCL printer driver.

TO CONFIGURE INSTALLABLE OPTIONS ON THE E-750 FROM THE 
PCL PRINTER DRIVER

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the E-750 icon, and choose Printing Preferences.
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3. Click the Configuration tab and specify the options installed on the E-750.

4. Select an installed option from the Available Options list, and click Add to move 
the option to the Installed Options list. 

.

Copier Type—Color-MFPe, Color-MFPe-ADU

Punch Option—Not Installed, 2 hole Punch Unit, 2/3 hole Punch Unit, 4 hole Punch 
Unit (F), 4 hole Punch Unit (S)

NOTE: Select 2/3 hole Punch Unit to use the Punch Option.

Sorter and Stapler—Not Installed, Finisher with Saddle Stitcher, Finisher with Stapler

Large Capacity Feeder—Not Installed, Installed

Auto Trapping—Not Installed, Installed

5. Click Apply, then click OK.

You are ready to connect to your network type (see the next section “Completing the 
Windows 2000/XP/Server 2003 printer connection”).

Configuring installed options and updating print options settings 
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automatically

If you have a TCP/IP-enabled network, you can automatically update your printer 
driver to reflect the options currently installed on the E-750. When the printer driver 
is first installed, the installable options have default settings that were set up in 
E-750 Setup or ColorWise Pro Tools. When you update the printer driver with the 
Two-Way Communication feature, you allow the E-750 to complete the actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to 
reflect the current color settings on the E-750. To access the Expert Color Settings 
options, click the Expert Settings tab in the ColorWise print option bar of the Fiery 
printing tab of your printer driver. For more information, see the Color Guide.
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SETTING UP TWO-WAY COMMUNICATION FOR POSTSCRIPT 
OR PCL PRINTER DRIVERS FOR WINDOWS 
2000/XP/SERVER 2003

NOTE: The procedures for the PostScript and PCL printer drivers on Windows 
2000/XP/Server 2003 are similar. The following procedure displays Windows XP 
illustrations using the PostScript printer driver. Differences are noted in the text.

1. On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP/Server 2003, click Start, and choose Printers and Faxes.

2. In the Printers window, select the icon for the E-750 PostScript printer driver. 

3. For the PostScript printer driver, choose Properties from the File menu.

For the PCL printer driver, choose Printing Preferences from the File menu.

4. Click the Configuration tab.

5. Select Two-Way Communication.

6. Enter the E-750 IP address or DNS name.

7. If you want your printer driver to display the current settings when opened, select the 
Update Fiery Driver When Opened option.
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8. Click Update.

9. Click OK.

Completing the Windows 2000/XP/Server 2003 printer 
connection
To print from Windows 2000/XP/Server 2003, you must:

• Set up network servers, if any.

• Set up the E-750 to accept print jobs from your computer.

• Configure a port on each Windows 2000/XP/Server 2003computer for the network 
type.

NOTE: The procedures for completing the printer connection for Windows 2000 and 
Windows XP are similar. Windows 2000 illustrations are used in the following 
procedure, with relevant Windows XP differences noted.

Completing the Windows 2000/XP/Server 2003 TCP/IP and Port 9100 or LPR 
connection

Once you have installed the PostScript and printer driver files, complete the setup 
for the TCP/IP and LPR connection as follows:

• Prepare the E-750 to accept print jobs using TCP/IP and LPR protocols. 
For details, see the Configuration Guide.

• Enable LPD or Port 9100 from the E-750 Control Panel.  
For details, see the Configuration Guide.

• Configure the computer for the TCP/IP connection.

To do this See

Configure the TCP/IP (LPR port) 
connection

“Completing the Windows 2000/XP/Server 
2003 TCP/IP and Port 9100 or LPR 
connection” on page 1-37. 

Configure the IPX (Novell) connection “Completing the Windows 2000/XP/Server 
2003 IPX (Novell) connection” on page 1-42.
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Before you continue, contact the system administrator for the IP address assigned to 
the E-750, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP protocol should already be installed on the Windows 2000/XP/Server 
2003 workstation.

NOTE: You can also set up the LPR connection by installing Print Services for UNIX, 
which is supplied as an add-on Windows component with your Windows 
2000/XP/Server 2003 CD. For more information, see your Windows documentation.

TO SET UP TCP/IP AND PORT 9100 OR LPR CONNECTION FOR WINDOWS 
2000/XP/SERVER 2003

1. Open the Properties dialog box for the E-750 and click the Ports tab.

2. Click Add Port.
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3. Select Standard TCP/IP Port for Available port types and click New Port.

4. Click Next. 

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

5. Type the IP address of the E-750.

6. Click Next.

7. Make sure that Generic Network Card is selected as Standard for Device Type 
and click Next.

8. Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box and click 
Close in the Printer Ports dialog box.



11-40 Installing User Software on a Windows Computer
9. Click Configure Port in the Ports tab of the Properties dialog box.

The Configure Standard TCP/IP Port Monitor dialog box appears.

10. If you have LPD printing enabled at the E-750 Control Panel, select LPR for Protocol 
and LPR Byte Counting Enabled under LPR Settings.

NOTE: You can also proceed without selecting LPR Byte Counting Enabled under 
LPR settings.
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11. If you have Port 9100 printing enabled at the E-750 Control Panel, select Raw. 

The port number 9100 automatically appears under Raw Settings. You can print to the 
printer connection selected for Port 9100 printing at the E-750 Control Panel.

12. Enter the name of the print connection.

For LPR, use print hold.

For Port 9100, manually enter the following port numbers for each print connection 
under Raw Settings:

direct: 9101

print: 9102

hold: 9103

13. Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.
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Completing the Windows 2000/XP/Server 2003 IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling E-750 print jobs. The file 
server should be configured with a print server and print connection for the E-750. 
For details, see your NetWare documentation.

• Prepare the E-750 for IPX printing.

• Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 
services should already be installed on the Windows 2000/XP/Server 2003 computer.

TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS 2000/XP/SERVER 2003

1. On Windows 2000, double-click My Network Places. 
On Windows XP, click Start, and then click My Network Places.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

3. Double-click the NetWare Tree or File Server on which the network administrator 
defined a print connection for the E-750.

You may have to log in to the file server to see the print connections.

4. Double-click the print connection defined for the E-750.
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5. If the NetWare server does not have a suitable driver for the E-750, you may be asked 
if you want to set up the printer on your computer. Click Yes.

6. Click OK to install the E-750 PostScript printer driver.

7. Follow the procedure that starts with step 6 on page 1-14.

When installation is complete, a new printer window appears, with the name of the 
print queue on the NetWare server.

8. Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for 
the E-750.

9. Click the General tab and click Print Test Page.

10. In the printer Job Notes field, type user and job identification information and  
click OK.

The Test Page remains listed in the queue window until it is printed.

The E-750 polls the NetWare server for print jobs in the print connection defined for 
the E-750. When you print, your PostScript files are spooled to that connection and 
transmitted over the queue “port” to the E-750.
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Setting up SMB printing on Windows 2000/XP/Server 2003

SMB printing (also known as Windows printing) allows you to install the printer 
driver and associated files, and print from your computer to a particular print 
connection (Hold, Print, or Direct) on the E-750. These instructions assume you have 
installed the TCP/IP protocol and Client for Microsoft Networks.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer 
description file. To set up printing to a second or third print connection, repeat the 
procedure, “To set up SMB printing on Windows 2000/XP”. If you install more than 
one printer, give each a descriptive name during printer driver installation, such as 
E-750-Print or E-750-Hold, so you can easily identify printers.

BEFORE YOU BEGIN

• Configure the E-750 for SMB printing in Run Setup>Network Setup > Service 
Setup > Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. For more information, see the Configuration Guide.

TO SET UP SMB PRINTING ON WINDOWS 2000/XP

1. Open My Network Places.

2. Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in Network Setup > 
Service Setup > Windows Setup  >  Server Name. For this information, see the 
Configuration page.

The amount of network traffic determines the amount of time required for the 
Browse function.

NOTE: You can also locate the printer using the Search feature on your Windows 
computer. Right-click My Network Places and click Search for Computers. Type the 
name of the printer and click Search Now.

If you are not able to locate your E-750, contact your network administrator.

3. Double-click the name of the E-750 to display enabled print connections.

NOTE: For a description of each print connection, see the Configuration Guide.
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4. Double-click the desired print queue (Direct, Hold or Print).

Setting up IPP printing with Windows 2000/XP/Server 2003

With Internet Printing Protocol (IPP), print jobs are sent to the E-750 over 
the Internet.

IPP printing is supported directly for Windows 2000/XP/Server 2003 computers. IPP 
printing is not supported on Windows NT 4.0.

NOTE: The IPP setup procedures are performed after installing the appropriate printer 
drivers (see “To install the PostScript or PCL printer driver for Windows 
2000/XP/Server 2003” on page 1-29).

BEFORE YOU BEGIN

1. Prepare the E-750 for TCP/IP printing.

2. Make sure the E-750 is configured for IPP printing. For more information, see the 
Configuration Guide.

3. Specify the printing destination on your computer.

TO SET UP IPP PRINTING WITH WINDOWS 
2000/XP/SERVER 2003

1. On Windows 2000, click Start, choose Settings, and then choose Printers. 
On Windows XP, click Start and choose Printers and Faxes.

2. On Windows 2000, double-click the Add Printer icon and click Next. 
On Windows XP, click Add Printer.

3. Select Network printer and click Next.
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4. Select “Connect to a printer on the Internet or on your intranet.” Type an IP address or 
computer name in the URL field.

The URL for the printer is the IP address or DNS name followed by “ipp” and the 
connection you want to print to (print, hold, or direct). Insert slashes between the 
different elements.

5. Click Next.

The Connect to Printer dialog box appears.

6. Click OK.

The Add Printer Wizard dialog box appears. 

7. If you are installing the PostScript printer for Windows 2000/XP for the first time, 
follow the procedure described on page 1-29.

If you have already installed the printer driver on your computer, choose the 
appropriate names from the Manufacturers and Printers lists and click OK. 

8. Indicate whether you want to make the E-750 the default printer and click Next.

9. Click Finish.
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Uninstalling the Printer Drivers
If you install the printer drivers using the installer, please use the Add/Remove 
Program. If you install the printer drivers using “Add Printer”, please use the Fiery 
Printer Delete Utility. If you install the printer drivers using SMB shared printing 
(either from the disk controller or from a Windows server), please just delete the 
printer icons.

Installing EFI Fiery Mail Port
The E-Mail Service provides a method to print and control the E-750 remotely. Jobs 
are sent to the E-750 in the form of e-mail attachments. You can set up e-mail printing 
on Windows computers by adding the EFI Fiery Mail Port software as a printer port.

To set up the E-750 for e-mail printing, see the Configuration Guide. After Setup has 
been performed, install the software from the User Software CD onto your Windows 
computer, and then add a port.

NOTE: Procedures are given for Windows 98/Me and Windows NT 4.0. Procedures for 
Windows 2000/XP/Server 2003 are similar to those for Windows NT 4.0.

TO INSTALL THE E-MAIL PORT MONITOR ON WINDOWS COMPUTERS

1. Open the EFI Fiery Mail Port folder on the User Software CD.

2. Double-click the Setup icon and follow the on-screen instructions.

When installation is complete, you are ready to configure the connection for the e-mail 
port monitor.

TO CONFIGURE THE CONNECTION FOR EFI FIERY MAIL PORT ON 
WINDOWS 98/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, right-click the icon for the E-750 printer driver.

For instructions on installing the printer driver, see “Installing the PostScript or PCL 
printer driver for Windows 98/Me” on page 1-2.

3. Choose Properties, and click the Details tab.
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4. Click Add Port.

5. Click Other and select EFI Fiery Mail from the list of ports.

6. Click OK.

7. Enter the basic information required to set up the e-mail port. 

Fiery’s E-mail Address—Enter the e-mail address of the E-750.

Outgoing Mail Server—Enter the name or IP address of the SMTP server for the port 
monitor to use.

8. Click Advanced.
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The E-Mail Port Configuration dialog box appears.

9. Enter the following information.

For Fiery Server:

E-mail Address—The e-mail address of the E-750.

Queue—The print connection on the E-750 that you want.

For Outgoing Mail Server (SMTP):

Server Name—The SMTP server to use.

From Address—The “from” address to insert in the e-mail.

For Options:

Break apart messages larger than—The maximum size of a single e-mail message 
is displayed. If a job exceeds this size, it is split into multiple messages, each not 
exceeding this size.

Status messages from E-750—When enabled, the Status option requests the E-750 to 
send status reports of the job via e-mail.
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10. Click OK.

The name assigned to the EFI Fiery Mail Port appears in the Details tab of the E-750 
printer driver.

11. Click Apply, and then click OK.

The connection for the EFI Fiery Mail Port has now been configured.

TO CONFIGURE THE CONNECTION FOR THE EFI FIERY MAIL PORT 
ON WINDOWS NT 4.0

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, double-click the Add Printer icon and click Next.

3. Specify printing using a Local printer and click Next.

4. In the window displaying a list of ports, click Add Port.

The Printer Ports dialog box is displayed, with the EFI Fiery Mail port listed as one of 
the available ports. 
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5. Select EFI Fiery Mail and click New Port. 

The Add Port dialog box appears.

6. Enter the basic information required to set up the e-mail port. 

Fiery’s E-mail Address—Enter the e-mail address of the E-750.

Outgoing Mail Server—Enter the name or IP address of the SMTP server for the port 
monitor to use.

7. Click Advanced.

The E-Mail Port Configuration dialog box appears.
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8. Enter the following information.

For Fiery Server:

E-mail Address—The e-mail address of the E-750.

Queue—The print connection on the E-750 that you want.

For Outgoing Mail Server (SMTP):

Server Name—The SMTP server to use.

From Address—The “from” address to insert in the e-mail.

For Options:

Break apart messages larger than—The maximum size of a single e-mail message 
is displayed. If a job exceeds this size, it is split into multiple messages, each not 
exceeding this size.

Status messages from E-750—When enabled, the Status option requests the E-750 to 
send status reports of the job via e-mail.

9. Click OK.

The Add Printer Wizard dialog box appears.

10. Click Next and follow the instructions for installing the printer driver for your 
Windows computer.
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Installing Fiery utilities
From the User Software CD, you can install the following Fiery utilities and user 
software:

• ColorWise Pro Tools

• Fiery Downloader

• Fiery Remote Scan (TWAIN Fiery Scan Module and Application)

• Fiery Printer Delete Utility

• EFI Fiery Mail Port (see “Installing EFI Fiery Mail Port” on page 1-47)

• Command WorkStation

• DocBuilder Pro (available as an option)

Includes Adobe Acrobat and PitStop, a plug-in for Acrobat.

NOTE: Do not attempt to install DocBuilder Pro from the User Software CD (by 
starting the setup.exe from the DBPro folder); it is automatically installed when you 
install Command WorkStation. Installing DocBuilder Pro from the User Software CD 
can cause unpredictable results. To use DocBuilder Pro, you must install Acrobat 
v5.0.5 and PitStop from the Fiery DocBuilder Pro option kit. To install Acrobat, see 
“Adobe Acrobat” on page 1-54. To install PitStop, see “PitStop” on page 1-55.

The Fiery utilities must be separately installed on each user’s computer. The 
installation of each utility is similar. Before you begin each installation, determine 
where you want to install each item on your hard disk. Otherwise, the software is 
placed by default in the Fiery folder inside the Programs folder, except for the Fiery 
Remote Scan TWAIN plug-in module.

The Command WorkStation installer also installs the Java files necessary to use Fiery 
Setup from Command WorkStation.

To use E-750 software as well as WebTools on Windows XP, you must install the JRE 
(Java Runtime Environment) on your computer. For more information on WebTools, 
see the Configuration Guide and the Printing Guide.
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To install the software on a Windows 2000 computer, you must have Service Pack 2 
installed on your computer. If not, a warning message alerts you to install Service 
Pack 2.

The TWAIN Fiery Remote Scan Module installer automatically creates a folder named 
Twain_32 in the Windows folder on your hard disk, and then installs the Fiery Remote 
Scan plug-in module into the folder.

 You access the Fiery Remote Scan plug-in from the TWAIN-compliant software using 
the TWAIN module. For details, see the Printing Guide.

TO INSTALL FIERY UTILITIES

1. Open the appropriate folder for the software you want to install.

2. Double-click the Setup.exe icon.

3. Follow the instructions in the Setup dialog boxes to complete installation.

NOTE: If the JRE (Java Runtime Environment) is not installed on your computer, the 
Command WorkStation installer will install the JRE first. After the JRE installation is 
finished, you should start the Command WorkStation installer again, in order to install 
Command WorkStation.

Adobe Acrobat
In Command WorkStation, the DocBuilder Pro feature and PitStop software plug-in 
work with Adobe Acrobat v5.0.5. To use DocBuilder Pro, you must install Adobe 
Acrobat v5.0.5, the PitStop plug-in, and Command WorkStation. Adobe Acrobat and 
PitStop are included on the Fiery DocBuilder Pro  CD in an option kit.

NOTE: To use DocBuilder Pro, you must have the dedicated dongle installed to the 
parallel port on your computer. If the dongle is not installed, refer to the 
documentation packaged with the dongle.

For more information about Adobe Acrobat for Windows, see the Readme.pdf file on 
the Fiery DocBuilder Pro CD.
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TO INSTALL ACROBAT

1. Insert the Fiery DocBuilder Pro CD in the CD-ROM drive.

2. Open the Acrobat folder, and double-click AutoPlay.exe.

3. Follow the on-screen instructions.

All languages are installed.

PitStop
PitStop is a plug-in for Adobe Acrobat v5.0.5 for use with DocBuilder Pro. You must 
first install Adobe Acrobat v5.0.5 as described in the previous section. PitStop software 
is included on the Fiery DocBuilder Pro CD.

TO INSTALL PITSTOP

1. On the Fiery DocBuilder Pro CD, double-click to open the PitStop folder.

2. Open the PitStop folder and choose the setup icon for the language you want to 
install.

English, French, German, and Spanish are the languages that are supplied and are 
indicated by a two-letter identifier. For example, in the file name, pp_5.setup_de.exe, 
“de” represents German. The identifiers for the other languages are: us (English),  
fr (French), and es (Spanish). 

3. Double click the PitStop setup icon you want.

The Welcome to Enfocus PitStop Setup dialog box appears, 

4. Click Next and then click Yes to the license agreement.

The Information dialog box appears.

NOTE: Make sure to complete the Enfocus Certified PDF Personal Information form. 
Otherwise, the form will appear every time you launch Adobe Acrobat.
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5. Click Next.

The Choose Destination Location dialog box appears. 

PitStop will automatically select the correct location for installation.

6. Click Next.

Setup is complete.

7. Click Finish.

For more information, see the PitStop documentation in Adobe Acrobat under 
Help > Plug-in Help\Enfocus PitStop Professional.

Using Fiery utilities for the first time
Before you can use the newly installed software, you must configure the connection to 
the E-750. Configuration of the Fiery utilities is similar. 

Fiery Printer Delete Utility is installed and used locally, so connection to the E-750 is 
not required before using the software.

TO USE FIERY PRINTER DELETE UTILITY

1. Click Start, choose Programs, and then choose Fiery. 

2. Click FieryPrinterDeleteUtility.

The Fiery Driver Uninstall Tool dialog box appears. 
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If any E-750 printer drivers are found on your computer, they are displayed.

3. To delete any of the displayed printers, select the printer name and click Delete.

A warning message appears.

4. Click OK to delete the selected printer driver.

A dialog box recommending that you restart your system appears after the printer 
driver is deleted.

5. Click OK to restart, or, to delete another printer driver, click Cancel to return to the 
Fiery Driver Uninstall Tool dialog box. Restart when you finish deleting printer drivers.
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Configuring the connection for Fiery utilities

The first time you start one of the Fiery utilities, you must configure the connection to 
the E-750. Similar configuration is used for all Fiery utilities, so any change in one 
configuration affects all the other connections. Configuration for most Fiery utilities is 
described in the following procedure. 

For configuration of specific Fiery utilities, see “Configuring the connection for 
Command WorkStation” on page 1-60.

BEFORE YOU BEGIN

• Print the Configuration page from the E-750 Control Panel.

This page contains information you need when configuring the connection, such as 
the IP address. For TCP/IP installations, you can use the DNS name of the E-750 
instead of the IP address. Make sure the E-750 is already registered in a Domain Name 
Server (DNS) on your network. For more information, see your Windows system 
documentation. 

TO CONFIGURE THE CONNECTION FOR FIERY UTILITIES

1. Start the utility for which you want to configure a connection. 

For Fiery Remote Scan, start the supported TWAIN-compliant software.

For details, see the Printing Guide.

2. If the No Servers Configured dialog box appears, click OK.

If the Choose Printer Device dialog box appears, click Add.

3. Enter the appropriate information for the E-750.

Nickname—Enter a name for the E-750. This name does not have to match the actual 
Server Name of the E-750.

NOTE: The nickname cannot contain any of the following seven characters: 
[ ] _ " ' <space> <tab>

Protocol—Choose the type of network protocol you are using from the menu.

NOTE: Fiery utilities are not supported over IPX/SPX. Command WorkStation is 
supported on Windows computers over TCP/IP.
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Server Name—Enter the IP address (or DNS name) of the E-750.

New Device—Enter the name of the device the E-750 is connected to:  Color-MFP.

NOTE: Type Color-MFP exactly as shown because this term is case-sensitive.

4. When you have entered all the information, click Add.

5. With the device name (Color-MFP) selected in the Devices list, click OK.

The E-750 appears in the list of available servers. The first line of the entry displays the 
nickname you gave the server, followed by the protocol you chose. The second line 
displays the device name. 

6. With the device name selected in the list of Available Servers, click Select to begin 
using the utility.

Modifying the configuration

Edit the configuration whenever there is any change to your E-750 server or network, 
such as a server name or IP address. If you change E-750 Setup information, do so 
before reconfiguring the connection.

TO MODIFY THE CONFIGURATION

1. To edit information for a E-750 in the list of available servers, select the E-750 by its 
nickname and click Modify. 

2. Make the necessary changes in the Modify Server Settings dialog box and click OK. 

Device name of the  
E-750 (Color-MFP)
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3. To add a new E-750 to the list of available servers, click Add. Configure the Add New 
Server dialog box as outlined in steps 3 through 5 in the previous procedure.

4. To remove a E-750, select the E-750 by its nickname and click Remove.

NOTE: The nickname cannot be modified.

Configuring the connection for Command WorkStation
The first time you start Command WorkStation, you are prompted to configure the 
connection to the E-750.

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION

1. Print a Configuration page.

The information on this page helps you locate the E-750, if it is not on the same local 
subnet as your computer.

2. Start Command WorkStation.

The Available Servers dialog box appears. All servers found in the local subnet 
are displayed. 
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3. If no E-750 servers were found, click the Manual tab to search by DNS name 
or IP address. Click Add to add the server to the Available Servers list.

4. Click the Auto Search tab and then click Advanced to search by either 
a range of IP addresses or the IP address and subnet mask. 

5. Click Search.

All available servers appear in the Available Servers list.
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6. Select the E-750 server you want to use and click Add.

The selected E-750 server appears in the Login Server dialog box.

7. Click the server name.

The Log In dialog box appears.

8. Select Administrator, Operator, or Guest and click Log In.

Your computer is connected to the server.
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Modifying the configuration

Edit the configuration whenever there is any change to your E-750 server or network, 
such as a server name or IP address. If you change E-750 Setup information, do so 
before reconfiguring the connection.

TO MODIFY THE CONFIGURATION

1. Start Command WorkStation.

The Login Server window appears.

2. Select the E-750 server for which you want to modify the configuration,  
and click Remove.

The Available Servers dialog box appears.

3. To add the modified E-750 server, follows steps 3 through 6 of the procedure, 
“To configure the connection for Command WorkStation” on page 1-60.

To modify the connection to the E-750, you must remove the server from the Login 
Server list and follow the procedure for configuring the connection.
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Installing color files from the User Software CD
You can copy additional color files from the User Software CD to your hard disk. 
Many of the files are PostScript files that you can download and print using 
Fiery Downloader.

Icm folder ICM monitor settings file and a device profile specially designed 
for use with the E-750 and particular copier/printer models. For 
instructions on installing, see “Installing the ICM profiles on a 
Windows computer” on page 1-65.

Clrfiles folder 
(inside the 
English folder)

Cmyk.ps, an 11-page, letter-size PostScript file to use for 
reference when defining CMYK colors in applications.

Pantone.ps, a 19-page, letter-size PostScript file that indicates the 
closest equivalent of PANTONE coated colors that the E-750 
and your copier/printer model can produce. The method used to 
print the Pantone.ps file differs depending on the Spot Color 
Matching setting. For more information, see the Printing Guide 
and the Color Guide.

Rgb_01.doc, a file you can print from Microsoft Word 97 or 
later to view available RGB colors.

Rgb_02.ppt, a file you can print from PowerPoint 6.0 or later to 
view available RGB colors.

Calibrat folder 
(inside the 
English\Clrfiles 
folder)

Four PostScript files of color patches for obtaining 
measurements: Custom21.ps, Custom34.ps, Stand21.ps, and 
Stand34.ps. The numbers in the file names refer to the number 
of patches on the page. The Custom files allow you to download 
measurement patches that incorporate the copier/printer’s 
current calibration set. The Standard files allow you to download 
standard measurement patches that bypass the copier/printer’s 
current calibration set. For information on using these files, see 
the Color Guide.

NOTE: These files are provided for expert users and should not be 
used for day-to-day calibration.
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Installing the ICM profiles on a Windows computer

The ICM profiles included in the Icm folder on the User Software CD are for use 
with ColorWise Pro Tools. You can also use the ICM profiles with applications that 
support ICC standards, such as Photoshop. For most ICC-aware applications, the files 
must be installed in a folder named Color in the System folder. For use with 
ColorWise Pro Tools, you can copy the files to a folder of your choice. 

You can upload additional ICC profiles with the Profile Manager in ColorWise 
ProTools. For more information on uploading and using ICC profiles with ColorWise 
Pro Tools, see the Color Guide.

TO INSTALL THE ICM PROFILES ON A WINDOWS COMPUTER

1. On the User Software CD, open the Icm folder.

2. If you are using Windows 98/Me, copy the profiles to the Windows\System\Color 
folder on your hard disk.

If you are using Windows NT or Windows 2000, copy the profiles to the 
Winnt\System32\Color folder on your hard disk.

NOTE: If a folder named “Color” does not exist in the System32 folder, create one and 
install the profiles into it.

If you are using Windows XP/Server 2003, right-click the profile you want and click 
Install Profile.

NOTE: The profiles are installed automatically to the 
Windows\System32\spool\drivers\color folder on your hard disk. 

Loading the monitor settings file
The Efirgb.icm monitor settings file can be used in Photoshop, or other applications 
that support ICM profiles, to define a source color space for printing to the E-750.

These instructions assume you have installed the ICM profiles included on the 
User Software CD. For more information, see the preceding section.

NOTE: The internal name of an ICC profile may vary slightly from its file name.

NOTE: If you use Fiery Remote Scan, install the monitor settings profile.



11-66 Installing User Software on a Windows Computer
TO LOAD THE RGB WORKING SPACE PROFILE FOR PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose RGB Setup from the Color 
Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. For Windows 98/Me, browse to the Windows\System\Color folder, select Efirgb.icm, 
and then click Load.

For Windows NT 4.0 or Windows 2000, browse to the Winnt\System32\Color folder, 
select Efirgb.icm, and then click Load.

For Windows XP, browse to the Windows\System32\spool\driver\color folder, select 
Efirgb.icm, and then click Load.

The Efirgb v1f file is displayed in the RGB menu of the RGB Setup dialog box.

5. Click OK.

For more information about ICM profiles, see your Photoshop documentation.
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Loading the ICM copier/printer device profile

This ICM profile defines the target color space for printing to the copier/printer.

These instructions assume you have installed the ICM profiles included on the 
User Software CD. For more information, see “Installing the ICM profiles on a 
Windows computer” on page 1-65.

NOTE: The internal name of an ICC profile may vary slightly from its file name.

TO LOAD THE ICM COPIER/PRINTER DEVICE PROFILE IN 
PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the Color 
Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the E-750 from the Profile menu.

NOTE: For more information on using profiles, see the Color Guide.
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5. Click OK.

For more information about ICC profiles, see your Photoshop documentation.

Loading monitor settings files and ICM device profiles in Photoshop 6.x

Once you have installed the Efirgb.icm monitor settings file and the ICM device 
profile for the E-750, they can be loaded at the same time in Photoshop 6.x.

TO LOAD THE MONITOR SETTINGS FILE AND ICM DEVICE PROFILE 
IN PHOTOSHOP 6.X

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and select Advanced Mode in the Color 
Settings dialog box.

3. Choose EFI RGB from the RGB menu.

4. Choose the profile that corresponds to the E-750 from the CMYK menu.

NOTE: For more information on using profiles, see the Color Guide.

5. Click OK.

For more information, see your application’s documentation. 

Installing the printer description files for Windows
The User Software CD contains printer description files for popular Windows 
applications. Adobe Pagemaker 5.0, 6.x, and 7.0 do not support automatic installation 
of printer description files from the Printers or Printers and Faxes Control Panel. To 
make the E-750 available in the Print and Page Setup dialog boxes of this application, 
copy printer description files to the appropriate location.
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TO COPY THE PRINTER DESCRIPTION FILES

1. On the User Software CD, open the English\Prntdrvr\Ps_drvr folder. Select the folder 
that corresponds to the system you are using.

For Windows 98/Me, select English\Prntdrvr\Ps_drvr\Win_9x_ME.

For Windows NT 4.0, select English\Prntdrvr\Ps_drvr\Win_NT4x.

For Windows 2000/XP, select English\Prntdrvr\Ps_drvr\Win_2K_XP.

2. Copy the printer description file for your E-750 to the appropriate location.

If you use Copy this file To this location

PageMaker 5.0 or later EF3T45E1.PPD
EF3T45U1.PPD

For PageMaker 5.0, 
\ALDUS\USENGLSH\PPD4
For PageMaker 6.0, 
\PM6\RSRC\USENGLSH\PPD4
For PageMaker 6.5, 
\PM65\RSRC\USENGLSH\PPD4
For PageMaker 7.0,
\PM7\RSRC\USENGLSH\PPD4
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The general steps for installing the E-750 user software and setting up printing on a 
Mac OS computer are as follows:

• Install the PostScript printer driver and printer description file.

• Set up the E-750 in the Chooser (Mac OS 9 or Mac OS X Classic mode) or in the 
Print Center (Mac OS X 10.2.x Native mode).

• Install the Fiery utilities (Fiery Remote Scan, ColorWise Pro Tools,Fiery 
Downloader, Command WorkStation LE, and Fiery Spooler).

• Configure the connection for Fiery utilities.

• Install the printer and screen fonts.

• Install the ColorSync profiles.

• Install additional color reference and application-specific files.

In addition to using the User Software CD, you can download printer drivers from the 
E-750 with the Installer WebTool (if the site administrator has enabled Internet access 
to the E-750). For instructions, see page 3-2.

Once you download the printer files, the installation process is identical to installing 
from the User Software CD.

Setting up the E-750 as a PostScript printer
To set up the E-750 as a PostScript printer, you must install the PostScript printer 
driver and the printer description file that corresponds to your copier/printer. The 
PostScript printer driver and printer description files are provided on the User 
Software CD. Printer drivers provide a way to communicate information on print jobs 
between your applications, the E-750, and any other PostScript printer connected to 
your computer.

When you install printer files from the User Software CD or printer files downloaded 
using the Installer WebTool, use the following procedures.

Chapter 2:
Installing 
User Software 
on a Mac OS 
Computer
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Setting up Mac OS 9.x printer drivers and printer description 
files
Instructions that follow are for Mac OS 9.x and Mac OS X Classic Mode. 

TO INSTALL THE ADOBEPS PRINTER DRIVER AND PRINTER 
DESCRIPTION FILE FOR MAC OS 9.X

1. Quit all open applications.

After you have completed installation, restart your computer.

2. On the User Software CD, open the English :  Printer Driver folder.

If you are installing from files you downloaded using the Installer WebTool, open the 
Printer Driver folder on your hard disk.

3. Double-click the AdobePS Installer icon.

4. Follow the on-screen instructions.

The AdobePS Installer installs the Adobe PostScript printer driver, and the printer 
description file that corresponds to the E-750.

NOTE: If you operate the E-750 in a copy shop, quick print shop, or service bureau, 
provide your customers with copies of the printer driver, printer description file, or 
ICC profiles you use for printing images, as well as any relevant documentation. This 
ensures that jobs they create and print to files are properly formatted for printing to 
the E-750.

Setting up the E-750 in the Chooser

After you install the Adobe PostScript printer driver and printer description file (see 
page 2-1), you must set up the E-750 in the Chooser in order to take full advantage of 
its features. This section describes how to set up the E-750 with the AdobePS printer 
driver.

TO SET UP THE E-750 IN THE CHOOSER

1. Select Chooser from the Apple menu.

Make sure AppleTalk is set to Active.

2. Select the correct AppleTalk Zone, if necessary.
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3. Click the AdobePS icon.

NOTE: Only the print connections (Direct, Hold, and Print) that have been enabled 
in Setup appear in the Chooser. 

4. Select a E-750 connection from the “Select a PostScript Printer” list and click Create.

Select the correct printer description file for your printer.

NOTE: You must set up each print connection separately. Repeat this step for all 
enabled connections.

5. With the same printer selected, click Setup, and then click Configure.

6. In the Installable Options dialog box, select the appropriate settings from the menus 
and click OK.

Copier Type—Color-MFPe, Color-MFPe-ADU

Large Capacity Feeder—Not Installed, Installed

Sorter and Stapler—Not Installed, Finisher with Saddle Stitcher, Finisher with Stapler

Punch Option—Not installed, 2 hole Punch Unit, 2/3 hole Punch Unit, 4 hole Punch 
Unit (F), 4 hole Punch Unit (S)

NOTE: Select 2/3 hole Punch Unit to use the Punch Option.

Auto Trapping—Not Installed, Installed

7. Close the Chooser.
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Setting up Mac OS X printer drivers and printer description files
Instructions that follow are for Mac OS X v.10.2.x. 

The User Software CD contains the following software for Mac OS X:

• PPD Installer—this application installs the PostScript Printer Description files 
(PPDs) necessary to print from Mac OS X v.10.2.x.

• Language folders—these folders contain copies of the files that will be installed by 
the PPD Installer. It is not necessary to open these folders or install them on your 
computer; the appropriate files will be installed by the PPD Installer.

TO INSTALL THE PRINTER DESCRIPTION FILES FOR 
MAC OS X

1. Quit all open applications.

2. Make sure that Print Center is not running on your computer.

Print Center updates the list of available printers when it restarts; if a printer 
description file is added while Print Center is running, you cannot select the associated 
printer model until you restart Print Center.

3. Insert the User Software CD into the CD-ROM drive.

4. Open the Printer Driver folder inside the OSX folder on the User Software CD.

5. Click the PPD Installer icon to start installing printer description files.

6. Follow the on-screen instructions.

The PPD Installer installs the printer description files that correspond to the E-750. 
The table below shows where the files are installed for each language.

Language Location of files

Dutch Rootdrivename:Library:Printers:PPDs:Contents:Resources:nl.lpro

English Rootdrivename:Library:Printers:PPDs:Contents:Resources:en.lproj

French Rootdrivename:Library:Printers:PPDs:Contents:Resources:fr.lproj

German Rootdrivename:Library:Printers:PPDs:Contents:Resources:de.lproj
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7. After you have completed installation, restart your computer.

Setting up the E-750 in the Print Center

After you install the printer description file (see page 2-1), you must set up the E-750 
in the Print Center in order to take full advantage of its features. This section describes 
how to set up the E-750 and configure installable options.

TO SET UP THE E-750 IN THE PRINT CENTER

1. Start Print Center.

Click the Print Center icon. Or you can select Applications from the Go menu, select 
Utilities, and then select Print Center.

Italian Rootdrivename:Library:Printers:PPDs:Contents:Resources:it.lproj

Japanese Rootdrivename:Library:Printers:PPDs:Contents:Resources:ja.lproj

Portuguese Rootdrivename:Library:Printers:PPDs:Contents:Resources:pt.lproj

Spanish Rootdrivename:Library:Printers:PPDs:Contents:Resources:es.lproj

Swedish Rootdrivename:Library:Printers:PPDs:Contents:Resources:sv.lproj

Language Location of files
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2. Click Add in the Printer List window.

3. Select AppleTalk or IP printing in the pop-up menu.

For AppleTalk, choose the AppleTalk Zone and choose the name of the E-750.

For IP Printing, enter the IP address or DNS name for the E-750 in the Printer’s 
Address field. Clear the Use default queue on server field. In the Queue Name field, 
enter print or hold. Make sure that LPR printing and the specified queue are enabled 
on the E-750. For more information about configuring TCP/IP printing, see the 
Configuration Guide.

4. For Printer Model, select the appropriate file for your language and E-750 using one of 
the following methods:

Select a manufacturer name to display the list of all printer models for that 
manufacturer. Scroll through the list to select your copier/printer model name. If you 
cannot find your printer model in the list for your copier/printer manufacturer, look in 
the Fiery folders.

You can also choose Auto Select to have the system select the correct file for your 
printer. If there is more than one file that corresponds to your printer, a dialog box will 
display a list of all valid files. If there are multiple files with identical names, cancel the 
Auto Select and choose the correct file from the Printer Model list as described above.

5. Click Add.

For more information about adding printers, see your Mac OS X documentation.
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TO CONFIGURE INSTALLABLE OPTIONS

1. Start Print Center.

Click the Print Center icon. Or you can select Applications from the Go menu, select 
Utilities, and then select Print Center.

2. Select your printer in the Printer List.

3. Choose Show Info from the Printer menu.

4. Select Installable Options in the pop-up menu.

5. In the Printer Info dialog box, select the appropriate settings from the menus.

Copier Type—Select which copier/printer is installed.

Large Capacity Feeder—Not Installed, Installed

Sorter and Stapler—Not Installed, Finisher with Saddle Stitcher, Finisher with Stapler
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Punch Option—Not installed, 2 hole Punch, 2/3 hole Punch, 4 hole Punch (F), 
4 hole Punch (S)

GA Features—Not Installed, Installed

6. Click Apply Changes.

Installing E-750 software and fonts
The Mac OS installers function essentially the same for each type of software. Before 
you begin each installation, determine where you want to install each item on your 
hard disk. Otherwise, the software is placed by default as follows:

• ColorSync profiles—ColorSync Profiles folder.

If you are using ColorSync 2.5, install the profiles into the ColorSync Profiles folder 

inside the System folder. If you are using an earlier version of ColorSync, install the 
profiles to the ColorSync Profiles folder inside the System : Preferences folder. The 
printer profile can be moved to a folder of your choice.

• Fiery Spooler, Fiery Downloader, Command WorkStation LE, and ColorWise Pro 
Tools—”Fiery” folder.

• Fiery Remote Scan—Supported TWAIN-compliant application software Plug-Ins 
folder

• Fonts—System folder : Fonts folder.

For instructions on installing Fonts, see “Fonts” on page 2-19.

TO INSTALL MAC OS SOFTWARE

1. Insert the User Software CD in the CD drive and double-click the Installer icon of the 
item you want to install, then follow the instructions in the installer dialog boxes.

2. If prompted, click Quit to close the software installer.

In order to use ColorWise Pro Tools, or Fiery Spooler, you must have Mac OS 
Runtime for Java (MRJ) installed on your computer.

If you do not have the appropriate MRJ installed, the installer automatically initiates 
the MRJ installation process.

3. To Install MRJ, follow the instructions in the installer dialog boxes.
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Installing MRJ on your computer
In order to use ColorWise Pro Tools, or Fiery Spooler on Mac OS 9, you must have 
Mac OS Runtime for Java (MRJ) installed on your computer.

If you do not have MRJ installed, the ColorWise Pro Tools, or Fiery Spooler installer 
automatically initiates the MRJ installation process.

NOTE: The respective installer prompts the MRJ installation from the User Software 
CD.

TO INSTALL MAC OS RUNTIME FOR JAVA ON MAC OS 9

1. Open the MRJ folder on the User Software CD and double-click Installer.

2. Read the Apple Computer Inc. License Agreement and click Agree to install the 
software.

3. Click Install.

Some files are installed.

4. Click Quit.

You are now ready to configure the ColorWise Pro Tools and Fiery Spooler 
connections to the E-750.

We recommend that you use the version of MRJ provided on the User Software CD 
with the E-750 software.

If you have a newer version of MRJ already installed on your computer and experience 
some difficulty using the E-750 software, either remove or relocate the MRJ files 
currently installed and reinstall the version of MRJ provided on the User Software CD, 
using the following procedure.

TO UNINSTALL MAC OS RUNTIME FOR JAVA ON MAC OS 9

1. Locate the System Folder on your hard disk.

2. Inside the Extensions folder, locate MRJ Libraries and remove it or move it to another 
folder.
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NOTE: If you find the “MRJ Enabler” file under Extensions, remove it or move it to 
another folder.

3. On Mac 9.x, locate the Apple Extras folder inside the Applications folder on your hard 
disk.

4. Inside the Apple Extras folder, locate Mac OS Runtime for Java, and remove it or move 
it to another folder.

5. Restart your computer.

Configuring a connection for ColorWise Pro Tools

The first time you use ColorWise Pro Tools, you are prompted to configure a 
connection to the E-750.

NOTE: ColorWise Pro Tools are supported only over TCP/IP networks. 

BEFORE YOU BEGIN

• Print the Configuration page from the Control Panel and note the IP address of 
the E-750.

TO CONFIGURE A CONNECTION FOR COLORWISE PRO TOOLS

1. Start the utility by double-clicking its icon.

The Choose Printer Device dialog box appears.
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2. If you have previously configured a connection to the E-750, you are ready to use 
ColorWise Pro Tools. If you have not configured a connection, click Add.

3. Enter the appropriate information for the E-750.

Nickname—Enter a name for the E-750. It does not have to match the actual server 
name of the E-750.

NOTE: The nickname cannot contain any of the following seven characters: 
[ ] _ " ' <space> <tab>

Protocol—TCP/IP is the only supported network protocol, so no selection is necessary.

Server Name—Enter the IP address (or DNS or hosts name) of the E-750.

New Device—Enter the name of the device the E-750 is connected to: Color-MFP. 
This device name appears in the Printer Setup section of the Configuration page.

NOTE: The device name is case sensitive; enter it exactly as it appears here.

4. When you have added all the information, click Add.

5. With the device name selected in the Devices list, click OK.

The E-750 appears in the list of available servers. The first line of the entry displays the 
nickname you gave the server, followed by the protocol. The second line displays the 
device name.
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6. With the device name selected in the list of Available Servers, click Select to begin 
using ColorWise Pro Tools.

Modifying the configuration

Edit the configuration whenever there is any change in your original configuration, 
such as a change of IP address. Change the specific E-750 Setup information before 
using the following procedure to configure the connection. 

TO MODIFY THE CONFIGURATION

1. To edit information for a E-750 in the list of available servers, select the E-750 by its 
nickname and click Modify. Edit information in the Modify Server Settings dialog box 
as necessary, and click OK.

2. To add a new E-750 to the list of available servers, click Add. Configure the Add New 
Server dialog box as outlined in steps 3 through 5 in the preceding procedure.

3. To remove a E-750 from the list of available servers, select the E-750 by its nickname 
and click Remove.

Configuring a connection for Fiery Spooler

Before you begin, print a Configuration page from the Control Panel and note the 
IP address of the E-750.

Device name of the E-750 



22-13 Installing E-750 software and fonts
TO CONFIGURE THE CONNECTION FOR FIERY SPOOLER

1. Start the utility by double-clicking its icon.

The Chooser dialog box appears.

2. Click Option.

3. Click Add.

4. Enter the appropriate information for the E-750.

Name—Enter the IP address (or DNS name) of the E-750.

New Device—Enter the name of the device that the E-750 is connected to: Color-MFP. 
This device name appears in the Printer Setup section of the Configuration page.

NOTE: Type Color-MFP exactly as shown; this term is case-sensitive.

5. When you have entered all the information, click Add.

6. With the device name selected, click OK.

The E-750 appears in a list of configured servers.

E-750 name and device name 
(Color-MFP)
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7. Click OK in the Configure dialog box.

The E-750 appears in a list of available servers.

8. With the E-750 selected in the list of available servers, click OK to begin using 
Fiery Spooler.

Modifying the configuration

Edit the configuration whenever there is any change to your E-750 or network, such as 
an IP address or device change. Change the specific E-750 Setup information before 
configuring the connection.

TO MODIFY THE CONFIGURATION

1. In the Chooser dialog box, click Option.

2. To edit information for a E-750, select the E-750 by its IP address or DNS name and 
click Modify. Edit information in the Settings dialog box as necessary, and click OK. 

3. To add a new E-750, click Add. Configure the Settings dialog box as outlined in steps 4 
through 6 in the preceding procedure.

4. To remove a E-750, select the E-750 by its IP address or DNS name, and click Remove. 

The list of available servers reflects the modifications you have made.

E-750 name and device name
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Configuring a connection for Fiery Downloader
When you start Fiery Downloader, you must specify the connection to the E-750.

BEFORE YOU BEGIN

• Print the Configuration page from the Control Panel and note the AppleTalk zone of 
the E-750.

TO SPECIFY A E-750 CONNECTION

1. Double-click the Fiery Downloader icon.

2. Select the AppleTalk zone in which the E-750 is located from the AppleTalk Zones  list.

The available servers appear in the Servers  list.

3. Select the E-750 in the Servers   list.

E-750 name and device name 
(Color-MFP)
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4. Click Connect.

The Fiery Downloader dialog box appears.

For information on how to use Fiery Downloader, see the Printing Guide.

Configuring the connection for Command WorkStation LE  
for Mac OS X
The first time you start Command WorkStation LE, you are prompted to configure 
the connection to the E-750.

BEFORE YOU BEGIN

• Print the Configuration page from the Control Panel and note the IP address of 
the E-750.
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TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION LE

1. Start Command WorkStation LE.

The Available Servers dialog box is displayed. All servers found in the local subnet 
are displayed. 

NOTE: The device name for the E-750 is Color-MFP.

2. If no E-750 servers were found, click the Manual tab to search by DNS name or IP 
address. Click Add to add the server to the Available Servers list.
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3. If no E-750 servers were found, click the Auto Search tab and then click Advanced to 
search by either a range of IP addresses or the IP address and subnet mask. 

4. Click Search.

5. Select the E-750 server you want to use and click Add.

The selected E-750 server is displayed in the Login Server dialog box.
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6. Click the server name.

The Log In dialog box is displayed.

7. Select a key for Administrator, Operator, or Guest and click Log In.

8. If prompted, enter the password for Administrator or Operator. 

Your computer is connected to the server.

To modify the Command WorkStation LE connection to the E-750, you must remove 
the server from the Login Server list and follow the procedure for configuring the 
connection.

Fonts
The Fonts installer on the User Software CD includes screen and printer fonts that 
correspond to the 136 built-in PostScript printer fonts on the E-750. The Font 
installer copies both types of fonts to the System : Fonts folder on your hard disk. To be 
available to applications, the screen fonts must remain in the System : Fonts folder. You 
can copy the printer fonts to a folder of your choice. 

NOTE: In the System : Fonts folder, when displayed by Kind, screen fonts appear as type 
“Font Suitcase” and PostScript printer fonts appear as type “PostScript font”.
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TO INSTALL SCREEN AND PRINTER FONTS

1. On the User Software CD, double-click the Fonts icon to start the Fonts installer. 

2. Click Install and restart your computer.

By default, the fonts are installed to the System folder : Fonts folder on your hard disk.

If you have any applications open, you must quit and restart them before the newly 
installed screen fonts are available.

Installing color files from the User Software CD
You can copy additional color files from the User Software CD to your hard disk. 
Many of the files are PostScript files you can download and print using 
Fiery Downloader.

The User Software CD contains the following color files:

ICC profiles 
(inside the 
ColorSync 
folder)

Install the ICC profiles into the ColorSync Profiles folder inside 
the System folder. 

Color Files 
folder (inside 
the English 
folder)

CMYK Color Reference.ps, an 11-page, letter-size PostScript 
file to use for reference when defining CMYK colors in 
applications.

PANTONE Book.ps, a 19-page, letter-size PostScript file that 
indicates the closest equivalent of PANTONE coated colors that 
the E-750 and your particular copier/printer model can 
produce. The method used to print the PANTONE Book.ps file 
differs depending on the Spot Color Matching setting. For more 
information, see the Printing Guide and the Color Guide.

RGB page 01, a file you can print from Microsoft Word 97 or 
later to view available RGB colors.

RGB page 02, a file you can print from PowerPoint 6.0 or later 
to view available RGB colors.
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Loading ICC profiles

The ICC profiles installed are used with ColorWise Pro Tools and applications that 
support ICC standards. 

These instructions assume that you have already installed the ICC profiles included on 
the User Software CD inside the ColorSync folder. For more information, see 
“Installing color files from the User Software CD” on page 2-20.

NOTE: The internal name of an ICC profile may vary slightly from its file name.

The following procedure describes installing the ICC profiles with ColorSync 4.0. 
For more information about ColorSync, see your application’s documentation.

Calibration 
folder 
(inside Color 
Files folder)

Four measurements files of color patches: custom21.ps, 
custom34.ps, standard21.ps and standard34.ps. The numbers in 
the file names refer to the number of patches on the page. The 
Custom files are provided to allow you to download 
measurement patches that incorporate the copier’s current 
calibration set. The Standard files are provided to allow you to 
download standard measurement patches that bypass the 
copier/printer’s current calibration set. For information on using 
these files, see the Color Guide.

These files are provided for expert users and should not be used 
for day-to-day calibration.
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TO SET THE COLORSYNC SYSTEM PROFILE

1. Choose Control Panels : ColorSync from the Apple Menu.

2. Select EFIRGB ICC v1f from the System Profile list.

When selected as the ColorSync system profile, EFIRGB ICC v1f sets the optimal 
source color space for printing to the E-750. The color space set by the EFIRGB ICC 
v1f profile is the same as that set by the EFIRGB setting of the RGB Source Profile 
print option. 

NOTE: The RGB Source Profile print option setting overrides the ColorSync system 
profile setting. 

3. Close the ColorSync dialog box.

For more information about ICC profiles, see your Photoshop documentation.
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Loading the monitor settings file
The EFIRGB ICC monitor settings file can be used in Photoshop or other applications 
that support ICC profiles to define a source color space for printing to the E-750.

TO LOAD THE MONITOR SETTINGS FILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu, and choose RGB Setup from the Color 
Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. Browse to the System :  Preferences :  ColorSync Profiles folder, select the EFIRGB ICC 
file, and then click Open.

NOTE: If you are using ColorSync 2.5, the ColorSync profile is located in System 
Folder : ColorSync Profiles.

The EFIRGB v1f file appears as the selection.

5. Click OK.
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Loading the ICC copier/printer profile
The ICC copier/printer profile enables RGB-to-CMYK conversions that are specific to 
the kind of copier/printer you are using. 

TO LOAD THE ICC COPIER/PRINTER PROFILE IN 
PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the Color 
Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the E-750 from the Profile menu.

NOTE: For more information on using profiles, see the Color Guide.

5. Click OK.

For more information about ICC profiles, see your Photoshop documentation.

Loading monitor settings and the ICC device profile in Photoshop 6.x/7.x

In Photoshop 6.x and 7.x, you can load the monitor settings file and the ICC device 
profile at the same time.

TO LOAD THE MONITOR SETTINGS FILE AND THE ICC DEVICE PROFILE IN 
PHOTOSHOP 6.X/7.X

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and then choose Advanced Mode.

3. Choose EFI RGB from the RGB menu.

4. Choose the profile that corresponds to the E-750 from the CMYK menu.

NOTE: For more information on using profiles, see the Color Guide.

5. Click OK.

For more information, see your Photoshop documentation.
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Fiery WebTools allow you to manage your E-750 remotely from the Internet or from 
your company’s intranet. The E-750 has its own home page, from which you can select 
a variety of functions.

For more information on using Fiery WebTools, see the Printing Guide.

Setting up Fiery WebTools
In order for network users to access and use Fiery WebTools, you must set specific 
E-750 options in Network Setup and Printer Setup. You also must prepare each user’s 
computer to communicate with the E-750 over the Internet or intranet.

For more information about Network Setup and Printer Setup, see the 
Configuration Guide.

TO SET UP CLIENT WORKSTATIONS TO USE FIERY WEBTOOLS

1. Enable TCP/IP networking.

2. Make sure the workstation has a valid, unique IP address.

3. Make sure a supported Internet browser is installed on the computer.

For more information on supported browsers, see the Quick Start Guide.

4. Make sure Java is enabled in your Internet browser.

For more information on setting up the E-750 and the network, see the 
Configuration Guide.

Chapter 3:
Downloading 
Installers with 
Fiery WebTools
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Using the Fiery WebTools Installer
The Installer WebTool allows you to download installers for printer drivers directly 
from the E-750 to your computer.

TO DOWNLOAD PRINTER DRIVER FILES WITH THE INSTALLER WEBTOOL

1. Start your Internet or intranet browser and enter the DNS name or IP address of 
the E-750.

2. Click the WebTools button.

3. Select a login level, enter a password if required, and click OK.

No password is required to log in as Guest. If the Administrator has configured Guest 
access, any user has full access to the Installer WebTool while logged in as Guest.

4. Click Installer.

5. Under the name of your operating system, click the name of the item you want 
to install.
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6. For installation of printer drivers, continue with the following instructions.

A dialog box appears, prompting you to save the file to the location you choose.

For Windows computers, a dialog box appears, offering you the choice of running the 
program across the Internet or intranet or saving it to disk.

For Mac OS computers, a folder named Printer Driver is downloaded to the desktop 
in a BinHex-encoded, compressed format. If your Internet browser is equipped with an 
expander utility, such as StuffIt Expander, the folder decodes and 
decompresses automatically.

7. For Windows computers, browse to the location where you want to save the 
Prntdrve.exe file and click Save.

For Mac OS computers, if the Printer Driver folder did not automatically decode and 
decompress, start the utility that performs that function.

8. For Windows computers, double-click the Prntdrve.exe file, browse to the location 
where you want to install the folder, and click Next.

The folder is installed to the location you specified.

9. Install the appropriate printer driver for your operating system.

For instructions on installing 
the printer driver for

See

Windows 98/Me “To install the PostScript or PCL printer driver for 
Windows 98/Me” on page 1-2

Windows NT 4.0/2000/XP/Ser
ver 2003

“To install the PostScript or PCL printer driver 
for Windows NT 4.0” on page 1-13

Windows 2000/XP “To install the PostScript or PCL printer driver for 
Windows 2000/XP/Server 2003” on page 1-29

Mac OS 9 “To install the AdobePS printer driver and printer 
description file for Mac OS 9.x” on page 2-2

Mac OS X “To install the printer description files for 
Mac OS X” on page 2-4
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Problems with the Fiery utilities on Windows computers
If you are experiencing problems with connections for the Fiery utilities, try 
the following:

1. Make sure the TCP/IP networking protocol is enabled. 

2. Make sure the connection is configured correctly for your site.

To check the current configuration, start a Fiery utility and choose Open from the File 
menu. Select the E-750 and click Modify to see current settings. If the settings are 
incorrect, you can change them in this dialog box.

On a Mac OS computer

Setting up the E-750 in the Mac OS 9 Chooser
If Auto-setup does not work and you are prompted to select the printer description file, 
select the appropriate E-750 file in your System :Extensions :Printer Descriptions 
folder, “E-750 US PS” or “E-750 EU PS”.

Installing screen fonts

If you experience problems installing the PostScript screen fonts from the User 
Software CD to the System folder : Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”

This folder must be located outside of the System folder.

3. Move fonts you are not using from the System folder : Fonts folder to the Uninstalled 
Fonts folder.
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4. Install the fonts from the User Software CD to a folder called CD fonts. Copy the fonts 
to the System folder : Fonts folder.

5. Create aliases to the System folder : Fonts folder and the Uninstalled Fonts folder.

6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and restart them in order to view 
and use the newly installed fonts.

Or, you can try combining fonts from multiple suitcases into a single suitcase.

Setting up the E-750 in the Mac OS X Print Center 
If Auto-setup does not work and you are prompted to select the printer description file, 
select the appropriate E-750 file in your hard disk drive : System  : Library : 
Printers : PPDs : Contents: Resources : language folder (for example, en.lproj) folder, “E-
750 US PS” or “E-750 EU PS”.
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